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8. Drag Cross Dissolve to the cut line between the two 
clips on the sequence (Figure 3). 

 Note: If you drag the transition left or right over the cut 
line, the rectangle on top of the clips changes to show 
the placement of the transition (Figure 4): 

• Ending at the cut line (at the out point of the first 
clip) 

• Centered on the cut line 

• Starting at the cut line (at the in point of the second 
clip) 

 Transitions placed at the beginning or end of a clip are 
called single-sided. All others are double-sided. 

9. In the Timeline panel, drag the current-time indicator 
(CTI) ahead of (to the left of) the transition and click the 
Play button in the Program Monitor. 

 The transition has a 1-second (30 frames) duration by 
default. You can change the default length in the 
General Preferences dialog box (select Edit > 
Preferences > General). 

 Note: You can replace one transition with another by 
simply dragging a new transition to the existing 
transition in the sequence. 

10. To change the default transition, select a new transition 
in the Effects panel and select Set Selected As Default 
Transition in the Effects menu (Figure 5). 

 
Figure 3 Transition at a cut line 

 

Figure 4 Three transition locations and icons 

 

Figure 5 Effects panel menu 
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Overview of video transition settings 
After you place a transition at a cut line between two clips, you will usually want to change the transition settings. 
You make those changes in the Effect Controls panel. Each transition has its own set of options, although many 
transitions have settings in common with other transitions. To see all the transition options and the transition time 
ruler, you will probably need to drag the edges of the Effect Controls panel to expand its height and width. Here’s an 
overview of what’s available: 

• Edge selectors: Change the orientation or direction of the transition. Some transitions can move from all eight 
primary cardinal compass points (N, NE, E, SE, etc.). 

• Duration: Set the length of the transition. 

• Alignment: Place the transition starting at the cut, ending at the cut, centered at the cut, or in a custom location. 
Custom Start appears as an option in the Alignment field only if you drag the transition to a custom location 
over the cut. 

• Start And End Sliders: Start a transition with part of the transition already completed or end it before its logical 
completion. For example, the Clock wipe can start with half the face showing the next clip or end with half the 
face showing the first clip. 

• Show Actual Sources: Display the starting and ending video frames of the transition. This can help you decide 
the transition duration or the placement of certain elements. For example, the Iris Box transition has the second 
clip appear in a tiny box within the first clip. You use the starting frame to help set where that box should 
appear in the clip. 

• Border Width: Adjust the width of the optional border on the transition. The default border is None. Some 
transitions do not have borders. 

• Border Color: Specify the color of the transition’s border. You can select a color from the color swatch or use 
the eyedropper to select the color from a video clip. 

• Reverse: Play the transition backward. For example, the Curtain transition closes and the Clock Wipe transition 
plays counterclockwise. 

• Anti-aliasing Quality: Aliasing is the jagged, stair-step edge common along sharply defined lines on computer 
monitors and TV sets. This is most noticeable when the transition is not a horizontal or vertical move. To get rid 
of aliasing (to soften that edge), you select Anti-Aliasing. This option is available for transitions that have 
borders. 

• Custom: Only a handful of transitions have custom settings. Here are some examples: Zoom Boxes—number of 
boxes, Band Wipe—number of bands, and Card Flip—Rows, Columns, Flip Order, and Axis. 

• Positioning Circles: Locate the starting and ending points of a transition within a clip’s frame. For example, Iris 
Star has the second clip appear in the first clip as a tiny star that grows to a full-screen clip. You use the starting 
positioning circle to place where in the first clip that tiny star appears. Most transitions don’t have positioning 
circles. 
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How to adjust reverse, custom, and positional circle settings 
How to change most of the transition settings is straightforward. However, reverse, custom, and positional circles 
need some explanation. Here is an overview of those three settings. 

1. Continue working with the clips you added earlier in 
this guide, or start a new sequence, add two clips to it, 
and trim their respective out and in points. 

2. In the Effects panel, open the 3D Motion bin and drag 
Curtain to the end of the last clip. 

 Note: The only placement option when applying a 
transition to the end of the last clip in a sequence is to 
have the transition end at the out point. This is a single-
sided transition (Figure 6). 

3. Click the Curtain transition rectangle at the end of the 
clip to select it and to display its parameters in the Effect 
Controls panel. 

4. Play the transition and note that the curtain opens. 

 That is the default action for the Curtain transition. 

5. Select the Reverse option and view the transition in the 
Program Monitor (Figure 7). 

 Note: Reverse changes the action of a transition. In this 
case, it causes the curtain to close at the end of the clip. 

6. Drag the Zoom Trails transition (Zoom bin) to the cut 
line between the two clips in the sequence. 

 Zoom Trails replaces Wipe. 

7. Click the Zoom Trails transition rectangle at the cut line 
between the two clips to display its parameters in the 
Effect Controls panel. 

 Zoom Trails has two options you have not seen up to 
this point: Custom (a large button at the bottom of the 
list of options) and a positioning circle in the Start Clip 
preview pane (Figure 8). 

8. Click Custom and change the number of trails to 20 
(Figure 9). 

9. Move the End preview screen slider to the left slightly 
so you can see how the transition will look as it finishes 
(Figure 8). 

10. Move the positioning circle in the Start screen to change 
the location where the zoom boxes will start and finish 
(Figure 8). 

 Note: Because there is only one positioning circle for 
Zoom Trails (some transitions have both start and end 
positioning circles), the transition starts and ends in the 
same relative position within the frames of the two clips.

11. Return the End preview screen slider all the way back to 
the right and play the transition. 

 
Figure 6 Curtain transition placed at end of clip 

 

 
Figure 7 Curtain transition 

 

 

Figure 8 Transition Clip preview panes 

 

 
Figure 9 Zoom Trails Settings dialog box 

 

Positioning circle 
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How to adjust transitions in the Effect Controls time ruler 
 

You can make several types of adjustments to transitions in 
the Effect Controls time ruler: 

• Adjust transition alignment: You can drag the 
transition to reposition it over the cut. 

• Move the cut line and transition together: This is 
the same as performing a Rolling Edit in the 
Timeline panel. As you move the cut, the transition 
moves with it. Move the cut line and transition 
together by positioning the cursor on the thin 
vertical cut line (the cursor changes from the Slide 
Transition tool to the Rolling Edit tool) and 
dragging left or right (Figure 10). 

• Change the transition in and out points: Use the 
time ruler to drag either end of the transition and 
precisely position it relative to the clips. Change the 
in or out points of the transition by positioning the 
pointer over the transition until the Trim-in or Trim-
out tool appears and then drag left or right 
(Figure 11). 

 

 
Figure 10 Rolling Edit tool 

 

 
Figure 11 Trim-out tool 
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How to use Source Monitor editing tools 
Trimming clips before placing them on the Timeline is helpful. You trim a clip by putting it in the Source Monitor, 
trimming it there, and then adding it to a sequence in the Timeline. When you use the Source Monitor to add a clip 
to a sequence, you can use an Insert edit or an Overlay edit. You can choose to add both video and audio, audio 
only, or video only. 

How to trim clips in the Source Monitor 

1. Start Adobe Premiere Pro and open an existing project 
that has at least four video clips with audio. 

2. Double-click a video clip in the Project panel. 

 The selected clip appears in the Source Monitor 
(Figure 1). 

 Note: You also can drag the clip from the Project panel 
to the Source Monitor. 

3. Drag the Source Monitor current-time indicator (CTI) to 
where you want to put the in point in the clip. 

4. Click the Set In Point button from the Source Monitor 
trimming tools (Figure 2). 

 A right-bracket appears in the time ruler, with a light-
blue shading to the right (Figure 1). 

5. Play the clip, look for a logical out point, and drag the 
Source Monitor CTI there. 

 Note: Rather than drag the CTI to a location in the clip, 
you can type in a timecode and go there directly. Click 
on the blue timecode (on the left side of the Source 
Monitor), type a time (hours, minutes, seconds, frame), 
and press Enter (Windows) or Return (Mac OS). 

6. Click the Set Out Point button from the Source Monitor 
trimming tools (Figure 2). 

 A left-bracket appears and the light blue shading falls 
between the in point and out point (Figure 1). 

7. Click the Go To In Point button and then the Go To Out 
Point button to navigate back and forth between the in 
point and out point. 

8. Play the entire segment by clicking the Play In To Out 
button. 

Figure 1 Source Monitor 

 

 

 
Figure 2 Source Monitor trimming tools 

In point     Out point 

Set In Point 
 
Set Out Point 

Go To In Point 
 
Go to Out Point 
 
Play In to Out 
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How to use the Source Monitor to add clips to a sequence 

9. In the Timeline panel, move the CTI to the beginning of 
the sequence. 

10. Check to see that the Video 1 and Audio 1 track headers 
are highlighted—targeted in Adobe Premiere Pro 
parlance (Figure 3). 

 To target a video or audio track, click its header. 

11. Click the Toggle Take Audio And Video button once or 
twice until it shows a filmstrip and speaker (the icon in 
Figure 4). 

12. In the Source Monitor, click the Insert button to place 
this clip at the CTI line in the sequence. 

13. In the Project panel, double-click a second video clip to 
put that clip in the Source monitor. 

14. Click the triangle to the right of the current clip’s name 
on the Source tab at the top of the Source Monitor 
(Figure 5). 

 The Source menu appears. 

 All clips added to the Source Monitor appear in this 
menu. You change the clip displayed in the Source 
Monitor by selecting it here. You can remove all clips 
from the Source Monitor menu by selecting Close All, 
or remove them one at a time by selecting a single clip 
and selecting Close. 

15. In the Source Monitor, set in and out points for the 
newly added clip. 

16. Check that the Timeline panel CTI is at the end of the 
first clip (it goes there automatically after an Insert or 
Overlay edit). 

17. In the Source Monitor, click the Insert button. 

 The newly added clip (the second clip) appears in the 
sequence to the right of the first clip (Figure 6). 

18. Add a third video clip to the Source Monitor and set in 
and out points for that video clip. 

19. In the Timeline panel, place the Timeline CTI between 
the first and second clips. 

 Note: You can use the Page Up or Page Down keys to 
jump backward or forward from one cut line between 
clips in a sequence to another cut line. In this case, 
pressing Page Up once should move the CTI to the 
proper cut line. 

 
Figure 3 Timeline panel with targeted tracks 

 

 
Figure 4 Source Monitor editing tools 

 

 
Figure 5 Source menu  

 

 
Figure 6 Insert edit 
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20. In the Source Monitor, click the Insert button to do a 
standard Insert edit. 

 The new clip is placed at the CTI and the clip that was 
previously to the right of the cut line is shoved farther to 
the right in the sequence to make room for the new clip 
(Figure 7). 

21. Add a fourth clip to the Source Monitor, and set in and 
out points for that video clip. 

22. In the Timeline panel, press the Page Up key to move 
the CTI to the cut line between the first and second 
clips. 

23. Click the Toggle Take Audio And Video button until 
you see the filmstrip icon without a speaker. 

 Selecting this option means the clip you add to the 
sequence will be video-only. 

24. Click the Overlay button (Figure 4). 

 The new clip covers the previously placed third clip, but 
because you selected video-only, the audio does not 
change (Figure 8). 

 Note: In Figure 8, the video portion of Clip 4 replaced 
all of the video portion of Clip 2 and some of the video 
portion of Clip 3, but the audio portions of Clip 2 and 
Clip 3 remain unchanged. 

25. Play the sequence to see how the Overlay edit works. 

Figure 7 Insert edit 

 

Figure 8 Video-only Overlay edit 
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How to create standard image, movie, and audio files 
In this guide, you export sequences, clips, and video frames to several standard computer-file formats. Later you will 
work with the Adobe Media Encoder to create files for distribution on DVDs or the web or on iPods, cell phones, 
and other mobile devices. 

You can export a single video frame as an image by selecting one of several file types. Or you can export a video 
clip, a portion of a clip, an entire sequence, or a segment from a sequence as an audio/video file, audio-only file, or 
video-only file. 

When you export a clip or sequence as a standard computer video or audio file, it is typically rendered without 
compression at the full resolution of the project. You will be able to edit these files later like any other video clip 
without loss of quality or performance. You might choose to export sequences or clips into uncompressed files for 
either of the following reasons: 

• To flatten the contents of a multitrack sequence into single video and audio tracks to use in another project 

• To convert a large project with many clips into a more manageable form 
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How to make single-frame image files 

1. Start Adobe Premiere Pro and open an existing project. 

2. In the Timeline panel, move the current-time indicator 
(CTI) to the video frame you want to export. 

3. Select File > Export > Frame. 

 The Export Frame dialog box appears (Figure 1). The 
most recently used image file type appears in the 
Summary area at the bottom of the dialog box. 

4. Click Settings to change to a different file type. 

 The Export Frame Settings dialog box appears 
(Figure 2). 

5. In the General Area, choose a format in the File Type 
menu (Figure 3). 

 Note: Three of the file types—Windows Bitmap 
(Windows only), Targa, and TIFF—are uncompressed. 
They retain the full image quality of the selected frame. 
GIF (Windows only) is a highly compressed format 
(about 20% as large as the other three formats) and does 
not retain the full image quality. 

6. You can deselect the Add To Project When Finished 
option if you choose. 

 If this option remains selected, the newly created image 
appears in the Project panel after you save it. 

7. Click Video (in the upper-left corner of the Export 
Frame Settings dialog box) to switch to the video 
settings (Figure 2). Note that you can change the frame 
size and pixel aspect ratio (Figure 4). 

 Note: When you export still images from NTSC DV 
clips for use in square-pixel graphics or video, you can 
prevent distortion by setting Pixel Aspect Ratio to 
Square Pixels (1.0) and changing the frame size from 
720x480 to 640x480 pixels. 

8. Click OK to close the Export Frame Settings dialog box 
and return to the Export Frame dialog box (Figure 1). 

9. In the Export Frame dialog box, navigate to the hard 
drive file folder where you want to store this image file. 
Give the file a name and click Save. 

 Note: You can create a still image directly from a clip in 
the Project panel. Simply select a clip and follow the 
steps used to create a still image from a frame in a 
sequence. The one drawback to this method: you can use 
only a clip’s first frame to make a still image. 

Figure 1 Export Frame dialog box 

 

Figure 2 Export Frame Settings dialog box 

 

Figure 3 Export Frame Settings General area 

 

 
Figure 4 Export Frame Settings Video area 
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How to export a clip or a set of frames within a clip 

1. Start Adobe Premiere Pro and open an existing project 
with a clip you want to export. 

2. Do one of the following: 

• To export an entire clip, select the clip in the Project 
panel. 

• To export a range of frames in a clip, do the 
following: 

o In the Project panel, double-click the clip to 
open it in the Source Monitor (Figure 5). 

o Drag the Source Monitor CTI to where you 
want the exported clip to begin and click the 
Set In Point button (Figure 5). 

o A right-bracket appears in the time ruler, with 
light-blue shading to the right. 

o Drag the Source Monitor CTI to where you 
want the clip to end and click the Set Out Point 
button. 

o A left-bracket appears and the light-blue 
shading falls between the in point and the 
out point. 

3. Select File > Export > Movie. 

 The Export Movie dialog box appears (Figure 6). 

4. Click Settings. 

 The Export Movie Settings dialog box appears. 

5. In the Range menu of the Export Movie Settings 
General area, select either Entire Clip or In To Out 
(Figure 7). 

 

Figure 5 Source Monitor Set In Point and Set Out 
Point buttons 

 

Figure 6 Export Movie dialog box 

 

 
Figure 7 Export Movie Settings, General area 
Range menu 
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6. In the General area of the Export Movie Settings dialog 
box, open the File Type menu (Figure 8) and select one 
of the following video file types (exporting audio is 
covered in the final section): 

• QuickTime: Creates a compressed or uncompressed 
video file. (In Windows, you must have QuickTime 
installed.) 

• Microsoft AVI: Creates a compressed or 
uncompressed video file. 

• Microsoft DV AVI: Creates an uncompressed video 
file. 

 Note: Uncompressed Microsoft AVI is used to create 
high-definition video only. Filmstrip and Animated GIF 
create sequences of image files to which you can add 
graphics in a process called rotoscoping. 

7 Click Video (in the upper-left corner of the Export 
Movie Settings dialog box) to display options in the 
Video area (Figure 9). 

 You can choose a compressor (if one is available for the 
file type you selected) and set color depth, frame size, 
frame rate, pixel aspect ratio, quality, and data rate. For 
detailed explanations of these items, see Adobe 
Premiere Pro Help. 

 Note: QuickTime and Microsoft AVI together have 
more than 20 codecs (compression/decompression 
algorithms) associated with them. Each video and audio 
compressor has attributes that work best under certain 
circumstances. For more background on compression, 
read the DV Compression Primer on the Adobe website 
at 
http://media.studio.adobe.com/go/DV_Compression_Pri
mer.pdf. 

8. Click Audio (in the upper-left corner of the Export 
Movie Settings dialog box) to display the options in the 
Audio area (Figure 10). 

 You can select an audio compressor and set a sample 
rate, sample type, channels (mono or stereo), and 
interleave. For detailed explanations of these items, see 
Adobe Premiere Pro Help. 

9. Click OK to close the Export Movie Settings dialog box 
and return to the Export Movie dialog box (Figure 6). 

10. Navigate to a hard drive location, give your file a name, 
and click Save. 

 Note: A message box appears, showing the status of 
rendering the movie. When it finishes (it can take 
several minutes depending on the length of the video), 
the message box closes. 

Figure 8 Export Movie Settings, General area, 
File Type menu 

 

Figure 9 Export Movie Settings, Video area 

 

 
Figure 10 Export Movie Settings, Audio area 
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How to export an entire sequence or a sequence segment 

1. Start Adobe Premiere Pro and open an existing project 
with a sequence you want to export. 

2. Do one of the following: 

• To export a sequence, select the sequence in the 
Timeline panel or click on its icon in the Project 
panel. 

• To specify a range of frames in a sequence to 
export, do the following: 

o Select the sequence in the Timeline panel. 

o In the Timeline panel, set the work area by 
dragging the work area bar handles to the in 
and out points of the segment you want to 
export (Figure 11). 

3. Select File > Export > Movie. 

 The Export Movie dialog box appears (Figure 12). 

4. Click Settings. 

 The Export Movie Settings dialog box appears. 

5. In the Range menu of the Export Movie Settings 
General area, select either Entire Sequence or Work 
Area Bar (Figure 13). 

Figure 11 Timeline panel work area bar handles 

 

Figure 12 Export Movie dialog box 

 

 
Figure 13 Export Movie Settings, General area 
Range menu 
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6. In the General area of the Export Movie Settings dialog 
box, open the File Type menu (Figure 14) and select 
one of the following video file types (exporting audio is 
covered in the next section): 

• QuickTime: Creates a compressed or uncompressed 
video file. (In Windows, you must have QuickTime 
installed.) 

• Microsoft AVI: Creates a compressed or 
uncompressed video file. 

• Microsoft DV AVI: Creates an uncompressed video 
file. 

 Note: Uncompressed Microsoft AVI is used to create 
high-definition video only. Filmstrip and Animated GIF 
create sequences of image files to which you can add 
graphics in a process called rotoscoping. 

7 Click Video (in the upper-left corner of the Export 
Movie Settings dialog box) to display options in the 
Video area (Figure 15). 

 You can choose a compressor (if one is available for the 
file type you selected) and set color depth, frame size, 
frame rate, pixel aspect ratio, quality, and data rate. For 
detailed explanations of these items, see Adobe 
Premiere Pro Help. 

 Note: QuickTime and Microsoft AVI together have 
more than 20 codecs (compression/decompression 
algorithms) associated with them. Each video and audio 
compressor has attributes that work best under certain 
circumstances For more background on compression, 
read the DV Compression Primer on the Adobe website 
at 
http://media.studio.adobe.com/go/DV_Compression_Pri
mer.pdf. 

8. Click Audio (in the upper-left corner of the Export 
Movie Settings dialog box) to display the options in the 
Audio area (Figure 16). 

 You can select an audio compressor and set a sample 
rate, sample type, channels (mono or stereo), and 
interleave. For detailed explanations of these items, see 
Adobe Premiere Pro Help. 

9. Click OK to close the Export Movie Settings dialog box 
and return to the Export Movie dialog box (Figure 12). 

10. Navigate to a hard drive location, give your file a name, 
and click OK. 

Figure 14 Export Movie Settings General area 
File Type menu 

 

Figure 15 Export Movie Settings Video area 

 

 
Figure 16 Export Movie Settings Audio area 
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How to export audio only 

1. Start Adobe Premiere Pro and open an existing project 
with a sequence or clip you want to export as an audio 
file. 

2. Select the sequence or a clip. 

3. Select File > Export > Audio. 

 The Export Audio dialog box appears (Figure 17). 

4. Click Settings in the Export Audio dialog box. 

 The Export Audio Settings dialog box appears 
(Figure 18). It offers four audio file types: Audio 
Interchange File Format, QuickTime, Microsoft AVI, 
and Windows Waveform. QuickTime and Microsoft 
AVI are primarily intended for audio/video files, but 
they also handle audio-only. 

5. Select a format in the File Type menu. 

6. Click Audio (in the upper-left corner of the Export 
Audio Settings dialog box) to display the options in the 
Audio area (Figure 19). 

 You can select an audio compressor and set a sample 
rate, sample type, channels (mono or stereo), and 
interleave. For detailed explanations of these items, see 
Adobe Premiere Pro Help. 

7. Click OK to close the Export Audio Settings dialog box 
and return to the Export Audio dialog box. 

8. Navigate to a hard drive location, give your file a name, 
and click OK. 

Figure 17 Export Audio dialog box 

 

 
Figure 18 Export Audio Settings file types 

 

 
Figure 19 Export Audio Settings Audio area 
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Peer review 
Name: _______________________________________________________ Date:________________________ 

Project: ______________________________________________________ 

Overview 
Revision is an important part of the design process. In addition to conducting review and redesign cycles personally 
and with your client, using peer review can also be beneficial to your project. Peer review occurs in many 
professional environments, and it is an essential skill to starting learning. 

When giving peer review, be sure to make both positive and negative points. Give critiques as suggestions, not 
commands. When receiving peer review, do not feel disenchanted or think you did a bad job based on one review. 
Every review is different and what one person may not approve, the next person may find exemplary. 

Process for presenting work for peer review 
• When presenting your work for peer review, state the purpose, audience, and goals of your video and point 

out any concerns you have. 

• When someone else presents work for you to review, your first response should be to reiterate their 
purpose, audience, and goals.  

• When the producer’s purpose, audience, and goals are clear, ask questions of the producer, make 
comments, and offer suggestions. 

• To conclude, have the producer summarize the suggestions and offer a plan for revision. 

Guidelines for giving comments and suggestions 
• Before making any comments, review the entire video and make sure you understand the producer’s 

intentions. 

• Point out the strengths as well as the weaknesses of the video (shot selection, writing, transitions, effects, 
and so on). 

• Offer suggestions, not commands. For instance, do not say “You should do this….” Instead, use “I” 
statements: “I see that…” or “I’m confused about....” 

• Be respectful and considerate of your peer’s feelings. Do not say or write anything you wouldn’t want to 
hear about yourself. There is no reason to be rude. 

• Make sure your comments are clear and specific so your peer knows what you are referring to. Give 
specific examples and point to video shooting techniques, editing techniques, script writing, and so on to 
make your point. (Comments such as “This is unclear” or “This is too vague” are too general to be helpful. 
Rather, make a comment such as “I’m confused by this clip because it seems out of place.”) 

• If you are writing your comments, reread them before giving them to your peer. Make sure your comments 
make sense and are easy to follow. 
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